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About Basemaps

Basemaps can be used to display reference information in the S1 Mobile Mapper application. The S1
Mobile app allows users to download or sideload via usb cable; esri or user created basemaps for offline
use. Each basemap can be used in S1 as a “basemap”, or “additional basemap” that sits on top of the
basemap. This strategy allows users to use transparency settings when creating basemaps to allow a
layered approach to display reference information needed while collecting field data or navigating in an
offline environment.

S1 supported basemap file formats include; multi-scale tile packages .tpk, (tpkx; a newer compressed
tile package format), Vector Tile Package (.vtpk - ArcPro only), Mobile Map Package file

(.mmpk - ArcPro only), or geo-referenced GeoTIFF image file. Basemaps can be shared to ArcGIS Online
(AGOL) and downloaded to mobile devices connected to WiFi or a cellular network or connected to a PC
and side-loaded to the mobile device.

NOTE: For ArcGIS Pro users, S1 Mobile now supports Vector Tile Packages (.vtpk). There are several
advantages to using .vtpk files, such as smaller file size and better resolution for devices with high
dpi. This file type is optimized for vector data. Share them the same way you would a TPK file, as
basemaps. This documents does not cover how to create them in ArcPro though.

Assumptions:
e Access to ArcGIS 10.2 or later (this tutorial was made using ArcMap v10.7.1).

About Tile Packages (.tpk) in ArcMap

Tile packages are a bundle of pre-rendered image tiles, generated for a specific area based on a user
defined tiling scheme at multiple scales. The tiles are zipped into a single .tpk file to facilitate sharing.
Unlike a paper map or a single digital image file, which presents a map at a single scale, a tile package
can present reference information at multiple scales and resolutions.

You may need to do extra design work on your map document to set up scale dependencies and symbol
sizes at differing scale levels to get the most out of the .tpk file format.

Below is an example of a tile package presented at different scales to demonstrate the use of scale
dependencies. Showing how adding more detailed information as you zoom in and setting label size and
symbol size appropriately will give a much more refined map product

How to create a tile package (tpk)

A tile package (.tpk) can take a considerable amount of time and resources to create, therefore it is
important to fine-tune the map document (.mxd) prior to publishing the tpk file. Once the tile package is
created, it can be used to quickly render lightweight image files to applications.

Step 1: Preparing the Map Document (.mxd)
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a. Itis recommended that you start using a New Map Document, rather than an existing one.

b. Add all the needed layers to the map.

c. Set the minimum and maximum Scales Range for each layer and label visibility under Layer

Properties. For example, small roads may not be visible Out beyond: 1:150,000 minimum scale
and IN beyond: <None> Maximum scale and labels can be “Use the same scale range as the

feature layer”. Some Highway symbols show scale Up to 1:249,000, then another set of symbols
for highways show scale at 1:250,000 and above.

To set scale ranges - right click the layer - click properties > General tab for layer scale and
Label tab for the label scale setup.

Display layers at certain scales

https://pro.arcgis.com/en/pro-app/latest/help/mapping/layer-properties/display-layers-at-certain-scales.htm
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e. ArcGIS Runtime Tools must be enabled before creating a TPK. Click Customize = ArcMap Option

- Click the Sharing tab = check the box to Enable ArcGIS Runtime Tools, then click OK.
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Step 2: Set the Data frame Coordinate System and Datum Transformation

a.

Select View = Data Frame Properties 2 Coordinate System tab.
In the search bar type: WGS 1984 Web Mercator and hit Enter or the search icon.
Select WGS 1984 Web Mercator (auxiliary sphere).

Click Transformations button.

[ Annotation Groups | Extent Indicators | Frame | Size and Position | Product Library |

General | DataFrame | Coordinate System | llumination | Grds | Feature Cache |

T v | | wos 1984 Web Mercator v &
oS e T e —
ew | Bookmarks Insert  Selection Geoprocessing Projected Coordinate Systems
= Data View . |[T50.000 = B World
= A WGS 1984 Web Mercator (auxiliary sphere)
O3 Layout View P . -
k= k@ =
Graphs 3
Reports 3
f Con
< Scroll Bars
Laye Status Bar Current coordinate system:
WGS_1984_Web_Mercator_Auxiliary_Sphere ~
H WKID: 3857 Authority: EPSG
= Projection: Mercator_Auxiiary_Sphere =
False_Easting: 0.0
False_Morthing: 0.0
3 Central_Meridian: 0.0
|Er Data Frame Properties... Standard_Paraliel_1: 0.0
= Auxdliary_Sphere_Type: 0.0
= Refresh 53 8 Linear Unit: Meter (1.0)
= M jj Pause Drawing Data Frame Properties v
*| &1 Pause Labeling Change the properties of the
El active data frame in your map,
GTRN Roads such as coordinate system.

oK | [ Cameel | [ Aoty |

Set applicable transformation. In screenshot below, data is Converting from
GCS_North_American_1983 - Into GCS_WGS_1984 transformation, Using:

NAD_1983 To_WGS_1984_5 -> (NOTE: transformations may be different where you

are) then Click OK to close the transformations window and OK to save changes and close Data
Frame Properties menu. This will take a few second to process.
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Step 3: Set Full Extent Command and Clip to Shape

a. Zoom and pan map to the maximum extent (project area) desired in the output tile package. The
larger the extent, the larger the output file. If a large extent is needed, consider making multiple

TPKs to reduce the file size.

b. Select View > Data Frame Properties - Data Frame Tab.

Q Untitled - ArcMap

File Edit | View | Bookmarks Insert Selection Geoprocessing Customize Windows Help
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Graphs 3
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Refresh

Pause Drawing

Data Frame Properties

|[j‘ Data Frame Properties...
~
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Change the properties of the
active data frame in your map,
such as coordinate system.

x/,h Pause Labeling

c. Inthe Extent Used by Full Extent Command, click the Specify Extent button.

d. Select Current Visible Extent and click OK (do not close the main Data Frame Properties).

Data Frame Properties

&gt Indicators | Frame | Size and Posttion | Product Library |

m‘ DETE Frame ‘Qordmateﬁystem | lumination | Grids

e. Back on the Data Frame Properties - Data Frame tab = under the Clip Options = choose Clip to

Shape = then click Specify Shape.

I Feature Cache | B =
Automatic w
| | Current Visible Extent
) outline of Features
Layer: Features:
I“&’ Timber Production Capability Class ;I All
Outling of Selected Graphic(s)
O Custom Extent Degrees
Top: 43.841312905 dd
Extent Used By Full Extent Command
- Left: -124,218425193 dd Right: -123.641576494 dd
(_) Extent of data in all layers (Default)
= Bottorn: 43.616404195 dd
® Other:
——
Clip Options
|No Clipping v

f. Choose Current Visible Extent to clip to the current view, and then click OK-> then OK to close.
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Extent Used By Full Extent Command

(_) Extent of data in all layers (Default) -

®) Other:

Specify Extent...

"’@“ Timber Production Capability Class J Al
Clip Options

Outline of Selected Graphic(s)
|C|i|3 to shape / | Specdify Shape... | () Custom Extent Degrees
43,841312905 dd

Exdude Layers. . Border: -124.218425193 dd 123541576494 dd

hd e
Clip Grids and Graticules E| 43.616404195 dd

() Qutiine of Features

Note: Alternatively, if you wanted to clip to a specific area (ex: District or Forest boundary), rather
than Current Visible Extent, specify Outline of Features. Then choose the Layer and specify which
features in the layer (set a definition quesrry on the ).

Data Frame Clipping [ <]

(O current Visible Extent

e Features:
[€ Timber Production Capability Class | [an ~

Outline of Selected Graphic(s)

An example
of clipping to

) Custom Extent Degrees
43.841312905 dd

-124,218425193 dd -123.641576494 dd

43.615404195 dd

Step 4: Set Map Document Properties
a. Select File > Map Document Properties. E=l
we.: [Timber production |
b. Fill in the Summary, Description, Author, Credits, and Tags somary: [ Map sy e e on bt e
sections. -

c. Click Make Thumbnail and then OK. =

Author: ‘ ORS30 Oregon State Office |
Credits ‘ Bureau of Land Management, Oregon State Office |
Tags: [BLMiw Oregon, Mobie GIs |

d. Then select File again - Save, to save the map document.

Hyperlink base:

Last Saved:

Last Printed:

Last Exported:

Default -
Geodatabase:  W:\Default.gdb
Pathnames: [[Istore relative pathnames to data sources

Thumbnait: Mak nei Delete Thumbnail

oK | [ Cancel |[ ey |

Step 5: Create Tile Package

There are two ways you can create and share a tile package from ArcMap.

e From the file menu method, described below.
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e Or, asecond option, especially if you have trouble with publishing from the file menu option is
to use the “Create map tile package” tool in the data management ArcMap toolbox. This option
gives a little more control over the setup of the tile package and also allows you to select the
.tpkx file format as an output option. Which is a compressed format that outputs smaller file
sizes for the same extent and tiling scheme (The toobox method is not in this tutorial, but may
be added later)

For additional information on tile packages for ArcGIS 10.7, see this ESRI help article here:
https://desktop.arcgis.com/en/arcmap/10.7/map/working-with-arcmap/about-tile-packages.htm

a. Select File > Share As - Tile Package...

Q) TP How-to - ArcMap

File | Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
O New.. Ctr+N | |[1:150000 v EFEE | P
F -
B Open-. “0 k@ MBS TR ook~ | 3| ® G ¢
Save Ctrl+S
Save As...
Save A Copy...
=1 Save, Export and Print
[ Shareas v | @@ Map Package...
Add Data » |G Tile Package...
HY  sign Out - lisiva@bim.gov_BLM_EGIS T ArcGIS Runtime Content...
03 AwcGIS Online.. B Service.. Tile Package
Page and Print Setup... Create a tile package from the
current map zipped up into one
& Print Preview... convenient file, and either upload
= it to ArcGIS Online or save it to
Print...
e Fn disk. Atile package contains a
Load Production PDF Settings... cache of tiles that you can use as a
basemap in ArcGIS Runtime
applications.
Export Map...
[E__Fynnrt Man and Rin BA%D Renart

b. Select the Tile Package tab, then specify the location on the network (If you plan to sideload file to
mobile device) or upload package to AGOL account (if users will download to mobile device from
an AGOL group.

Tile Package x

o Aralyze 38 Share @

et Tile Package
Tile Format
Item Description () Upload package to my ArcGIS Online account

Hood_PCT_tpk

®) Save package to file

W MyWork\Hood_PCT_tpk. tpk

|

c. Next, select the Tile Format tab. Then set the Tiling Scheme to ArcGIS Online/Bing Maps/ Google
Maps.

d. Set the Tiling Format to PNGS8.
e. Set Level of Detail by moving the slider bar. The greater level of detail, the larger the tile package

size and the longer it will take to generate the package. It is recommended that a package be no
more than 1gb in size if uploading and sharing via AGOL. Though larger files are allowed, larger


https://desktop.arcgis.com/en/arcmap/10.7/map/working-with-arcmap/about-tile-packages.htm
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files impact download times. Saving the file locally and sideloading to the mobile device is a better
option for large files.

o Arayze G share (~)

Tie Padkage Tile Format

Tile Format

Tiling Scheme: [ rcES Oniine { Bing Maps | Googie Maps v]

Tile Format: PNG8 hs

Item Description

Approximate Cache Size: 92Mb

Levels of Detail

Choose the number of levels to areate for this tile package.  Alllevels up to and indluding the
selected level will be generated.

Highest Level of Detail: 180f 24

Level: 17

Scale: 1:4,513.98

City Block

f. Select the Item Description tab—> Populate any fields missing required information in the form.

g. After filling in the Item Description fields—> Click Analyze on the top right side.

= Package

Item Description

= Format
Summary {required):

:m Description Testing How-To create a tpk file, .

h. A table will appear displaying any Errors or Warnings about your map document.

i. Fixall Errors & before proceeding. Most errors can be corrected automatically by double

clicking on the Error Icon. Then click Analyze again to see if the error was corrected.

Pro tip; Large extents with high level tiling schemes can take a long time to create. Set a small map
extent area once you think you have your map set up with scale dependencies and symbol sizes etc.

Then share this small area initially to verify the output file symbology and scale dependencies turn out as
you expected. Once this is verified, go ahead and set the real extent that you want to export the
basemap at and share again.

EEE Share

j. Afterall red errors are corrected, click on the top right, to create the tile package.
Depending on the level of detail you chose, this tool will run for several minutes to several hours
to complete.

Creating a GeoTiff - Geo-referenced Image File

Unlike tile packages, which present a map at multiple scales, a GeoTIFF is a single image at a single map
scale. These are very quick and easy to generate and share, however, they may not be appropriate for
viewing on the mobile device at all map scales (blurry upon zooming in or too cluttered when zoomed
out). Not recommended for geographic areas larger than a section or two
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Due to certain limitations, GeoTIFF files cannot be added directly to a web map or applications. But
can be added to ArcGlIS Online (AGOL) as a shared download only.

Step 1: Open a New Blank Map Document

a. When preparing the Map Document, it is recommended that you start with a New Map
Document, rather than an existing one. Add only the layers needed to create this image.

b. Open ArcMap = Select Blank Map = Click OK.

c. Name and Save the New Map Document.

Step 2: Set Data Frame Coordinate System and Datum Transformation

Note: A Map Document’s Data Frame properties must include:

e Set the Coordinate System to WGS 1984 Web Mercator (auxiliary sphere).

e Apply a datum Transformation if map contains data using another Coordinate Source (ex.

NAD83 data).

e Set the Frame Background color to No Color.

a. Select View - Data Frame Properties - Coordinate System tab. @ ™How-to- archiap

b. In the Search bar - type: WGS 1984 Web Mercator and click 8 a8

Enter or click the search icon a

c. Select WGS 1984 Web Mercator (auxiliary sphere) = Click Apply

(do not click OK, yet).

d. You may get a Warning pop-up 2 If so, click the Transformation

button on that pop-up.

File Edit | View | Bookmarks Insert
0 B Data View
Q Layout View
Graphs
Reports

Scroll Bars
Status Bar

Table Of Con

Hio

Selection
k| @

[*1" Data Frame Properties...

o Refresh

Il__Pause Drawina

F5
o {Data Fi

e. (If you do not get a Warning pop-up, you will still be on the Data Frame Properties pane = click
on the Transformation button below).

T v ['Wes 1384 Web Mercator | & | @ -t

& WGS 1984 Web Mercator [asiliary sphere)
- - wTTEd parallel = )

VIGS 1584 Y, Megamy gy, Gofiere

Linear Uit Meter (L0}

OK

Annotation G Extert ndcntors | Frame | S and Postion | Product Ubeey
Genersl | Duts Frame | Cotrdnale System | Bueasion | Geds Featre Cozhe

Canosl

This coardinate system has a geographic coordinate system that differs
from one or more data sources in the map.

Alignment and accuracy problems may arise unless there is a correct
transformation between geographic coordinate systems.

e —
Use the Transformations button to —
set or change these transformations. ¢ Transformations. . .

Do you wish to use this coordinate system anyway?

[Jpon't warn me again in this session

[]Don't warn me again ever

No warning pop-up? = find the
Transformation button at the bottom
of the Data Frame Properties pane.

f. Set applicable transformation. After clicking the Transformation button = Convert from: GCS
North America 1983 = Into: GCS WGS 1984 - Select - Using: NAD_1983 To_ WGS_1984 5
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G hic Coordinate System Transfor C ”
Convert from:
GC5_WGS_1984
Into:
IGCS?WGS?l'iS“ v I Add...
Using (choices are sorted by suitability for the layer's extent):
INAD7 1983 _To_WGS_1984_5 v I New...

Method: Coordinate Frame - dx=-0.991000 dy=1.907200 dz=0.512900
rx=-0,025790 ry=-0.009650 rz=-0.011660 s=0.000000

About geographic transformations

g. Click OK to close the transformations window and OK to save changes and close Data Frame
Properties menu.

Step 3: Set Export Extent & Export Image

a. Zoom or pan map to the desired extent to be included in export. Do not have a map scale greater
than 1:500,000 when exporting geo-referenced maps. In fact, it is recommended to have a map
scale of 1:100,000 or better (1:50,000, 1:24,000, 1:10,000) to achieve a readable image file.

ookmarks Insert  Selection Geoprocessing  Customize  Windows  Help
B x| ¢>-m%mw:
——

MR ] @' 3 @ = H!ER ; ORTools k
b. Export Map document. Select File = Export Map.
¢. Onthe General tab, set the Resolution = 250 dpi
@ @ < n >
Metwork
Network | - i Fie name: [ TPK_Example_mage v s |
Fle rame [TPK_Bample_image v [Csae | Smeastpe [T | ==
Swveastipe:  |TFF v| [ cancel |

~ Options

Fnrmal |
Resaluton ‘

= Options

Ger\em\
Calar Mode: L J

Compression
Widh: 502 pocls
Hogh s S
Wiite Word Fi
[ it Wotd Fie [V Wite GeoTIFF Tags

d. On the Format tab, set the Color Mode to 24-bit True Color, Compression to None, Background
Color to No Color, and check the box next to Write GeoTIFF Tags.
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e. Give the output file a name = Set the Save as Type 2> e =
TIFF or Layout GeoTiff e L Jerem &
*
f. Se?lect where to .save your Image file from the upper. = _
window, then click Save to export the current map view | DD ol o
to a geo-referenced map. | [
[ |

This PC

Upload & Share Basemaps to ARCGIS ONLINE FOR ORGANIZATIONS

Network
File name: [TPK_Howso} v [
Save astype TIFF ) v Cancel

If you created a local copy of a basemap and decide you want to share it to AGOL this section describes

how to do that. To share a package to ArcGIS online, your Esri Account needs to have a minimum role

of “Contributor” in the BLM org, and all Forest Service accounts should work. S1 Supported tile package

file types include: Tile Package (.tpk or .tpkx; a newer compressed tile package), Vector Tile Package
(.vtpk - ArcPro only), Map Package (.mmpk - ArcPro only), or a geo-referenced GeoTIFF image file.

Step 1: Log into your ArcGIS Online (AGOL) for Organization account.

a. Logininto AGOL by going to:
BLM: https://blm-egis.maps.arcgis.com/home/content.html
FS: https://usfs.maps.arcgis.com/home/index.html

b. Then - Signin.

c. Click Content at the top of web page.

Home Gallery Map Scene Grouprgamzat\'on

d. Then click the My Content selection.

Groups Content Organization O\ Q

My Content My Favorites My Groups My Organiz

e. Click New Item - then Drag and drop your file in the window or select a file from Your device to
add your geo-referenced image (TIFF) or tile package (.tpk) to the ArcGIS Online for Organizations.

Drag " drl}l} w )
@ I Q. sd — & Google Drive 2 Dry

f. Enter at least one Tag to identify your layer and a summary = Then click Save.
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Step 2: Share Content

a. In AGOL, go to My Content, click on the name of your geo-referenced image (TIFF) or tile package
(.tpk) to see its information.

Overview ge Settings

b. Then click the Share button on the content properties screen.

|
‘ ‘ Share
|

Metadata ‘

c. Select to be the owner, where only you see the data or choose the Group(s) you wish to share this
layer with.

d. If you are choosing to share with groups in your organization = then select Organization for the
sharing level = then click the Edit group sharing button to select which groups you want to share
it with.

Share >

Set sharing level 9 Revert

@ Owner
Owner of the item(s) has access

5 Organization
° All members of your organization have access

@ Everyone (public)

Some share level options are limited by your sharing privileges.

Set group sharing

None yet

e. After selecting the groups in your organization that you want to share the data with, = Click OK
and Save.

< Group sharing

Q_  Search groups

2groupsselected [NEITIISREto

BLM OR SO AGOL - §1 testing fun shop

Filters

~ Owner

M*§ BLMOR SO GIS S1 M*S Training

=. .“
{“‘-,-- BLM OR SO GIS-Test

BLM OR SO Runtime SDK Development - Refactor R&D

Group membership

setting

> Special Groups

> Date Created

f. Now when using the S1 Mobile Mapper application, users belonging to the Group will be able
to see and download the geo-referenced image (TIFF) or any of the supported tile package

formats as a basemap.
When launching S1-> go to Download Data = Map Data = select a Group = select ‘your new

basemap’.
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